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Introduction
One of Tabs3 Billing’s most powerful features is the flexibility to customize how your statements look
when generated for each client. Configuration of the statement format occurs at various levels.
These levels include the following:
Tabs3 Billing Customization

page 1

Statement Customization

page 3

Statement Printer Setup

page 7

Statement Template

page 8

Email Template

page 14

Client Setup

page 19

Statement Notes

page 22

Statement Designer

page 29

Bitmaps

page 33

Trust Accounting Software

page 35

Purpose of Guide
The Tabs3 Billing Statement Formatting Guide covers the various options for customizing your billing
statement to look the way you want it to look. It includes information on mailing and emailing
statements, designing the statement layout, changing the way information is formatted, and more.
A separate Statements Guide includes information for how to generate statements. Additional
guides for other software features are also available on our Web site at:

Tabs3.com/support/docs.html

Tabs3 Billing Customization
The first level of defining the statement format can be found in Tabs3 Billing Customization. These
options are firm-wide and affect all clients.

Setting Up Tabs3 Billing Customization
Menu: Utilities | Customization
Home: All Actions | Setup | Customization

The Customization tabs we will be looking at include the Main tab, Options tab, Rates tab, and
Client Defaults tab.
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Figure 1, Customization - Main tab

Figure 2, Customization - Options tab

Figure 3, Customization - Rates tab

Figure 4, Customization - Client Defaults tab

Main tab

The Main tab allows you to select whether email
statements will be sent via Microsoft® Outlook® or an
SMTP server.

Options tab

The Options tab allows you to define your aging periods
and also allows you to specify if statement numbering will
be implemented at the firm level or the client level.
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Rates tab

The Rates tab includes information regarding sales tax and
finance charge.
l

l

Client Defaults tab

You can specify if you want sales tax charged for
fees, expenses, or advances. Up to nine different
sales tax rates can be defined. The sales tax feature
in Tabs3 Billing is very sophisticated, allowing you
to specify whether or not individual transactions
will be taxed.
The Rates tab can also be used to define whether
you want a finance charge assessed, if the finance
charge is subject to a finance charge, and if you
want to assess a minimum finance charge. Up to
five different finance charge rates can be defined.

The Client Defaults tab allows you to select the default
settings for new clients.

Statement Customization
The next level of defining the statement format can be found in Statement Customization. Statement
Customization allows you to define many additional firm-wide statement formatting options.

Setting Up Statement Customization
Menu: Statements | Statement Setup | Customization
Home: All Actions | Statements | Statement Setup | Statement Customization

Statement Customization includes the following tabs:
l
l
l
l
l

Options
Terminology
Headings
Cover Stmt
Months
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Figure 5, Statement Customization
Options tab

Figure 6, Statement Customization
Terminology tab

Figure 7, Statement Customization
Headings tab

Figure 8, Statement Customization
Cover Stmt tab
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Figure 9, Statement Customization
Months tab

Options tab

The Options tab allows you to specify if you want the
previous balance line to print at the beginning of the
statement or after fees and costs, whether you want nonbillable hours to print, and where you want the Courtesy
Discount to print. You can specify a number of blank lines
or a page break between combined statements, whether
you want fees double spaced, and if you want credits
included on invoice format statements. You can specify if
you want finance charges on invoice format statements
and whether you want blank miscellaneous lines printed.
You can specify whether you want the statement date to
be printed in MM/DD/YYYY format or spelled out. You can
specify whether current work will be included in past due
amounts and if you want a combined total of all due
amounts on a statement. You can specify whether you
want “0.00“ to print for billable transactions with zero
amounts or not print an amount at all.
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Terminology tab

The Terminology tab contains modifiable statement
terminology. There are over 70 different areas of statement
terminology that can be modified. For example, if you
don’t like the terminology “Balance Due,“ you can change
it to whatever you like, such as “Total Amount Due.“ Or, as
another example, you can change the “For Current
Services Rendered“ line to read “Professional Services.“ If
desired, you can print optional headings for the fee,
expense, advance, and payment sections of the statement.
Tabs3 Billing also allows you to embed the statement date
or cut-off dates in many of the statement terms. You can
also apply bold, italic, and underline attributes to the
statement terminology. You can configure Tabs3 Billing so
the expenses and advances combine into one section on
the statement. You can specify if the client’s account
number, the statement number, the page number, or the
term “Continued“ will print on statements. You can specify
if you want the contact name to print before the client
name.

Headings tab

The Headings tab allows you to enter up to nine lines of
text for your firm’s name and address, thus allowing you
to use plain paper instead of pre-printed letterhead for
your statements. These nine lines can alternatively be used
to insert any type of global notes that you want printed at
the top of every statement. You can also enter up to four
lines of optional text that prints at the end of each
statement. Many firms use these lines for a message
regarding finance charge policy, payment terms, or
perhaps a seasonal message. Alternatively, you can use a
bitmap image file for the statement heading or you can
create a custom heading and statement notes using the
Statement Designer.

Cover Stmt tab

The Cover Stmt tab allows you to customize cover
statement terminology and specify whether you want
Client IDs included on the cover statement.

Months tab

The Months tab contains the names of the twelve months
of the year. These names are used if you customized Tabs3
Billing to spell out the statement date.
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 10, Customizing Statements Video
Statement Customization Segment

Printer Setup
The next level of defining the statement format can be found in the Tabs3 Billing Statement Printer
Setup.

Statement Printer Setup
Menu: File | Print Setup | Statement Setup button
Home: All Actions | Setup | Print Setup | Statement Setup button

You can use any Windows printer to generate statements. You can specify the font you want used,
the paper size and source, and whether you want envelopes printed with statements. If you plan on
using the nine lines specified in Customization for the statement heading, you can specify a heading
font. As an alternative, you can include a bitmap of your firm’s letterhead allowing you greater
formatting flexibility. If you will be using the custom page layouts created by the Statement Designer
(page 29), you must select the Enable Statement Designer Layouts check box as shown in Figure 11.
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Figure 11, Print Setup - Statement Setup

Statement Templates
The next level of defining the statement format can be found in the Statement Templates window.
Statement templates determine many options pertaining to the format of the billing statement.

Defining Statement Templates
Menu: Statements | Statement Setup | Statement Templates
Home: All Actions | Statements | Statement Setup | Statement Templates

Each statement template includes the following tabs:
l
l
l
l

General
Fee Format
Cost/Payment Format
Layouts
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Figure 12, Statement Templates
General tab

Figure 13, Statement Templates
Fee Format tab

Figure 14, Statement Templates
Cost/Payment Format tab

Figure 15, Statement Templates
Layouts tab

General tab

The General tab is used to specify invoice or statement
formatting, billing history options, past due messages and
statement notes.
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Fee Format tab

The Fee Format tab is used to determine whether fees
print and, if so, whether timekeeper initials, dates, hours,
hourly rates, and amounts are included. Subtotaling of
fees is defined here. An optional fee recap by timekeeper,
timekeeper level, or rate can also be set up. The recap can
include hours, timekeeper levels, rates, and a total amount.

Cost/Payment Format tab

The Cost/Payment Format tab is used to specify whether
expenses and advances print and, if so, the format used on
the statement. You can also indicate whether payments
will be shown in detail, be subtotaled by date, or show
totals only.

Layouts tab

The Layouts tab is optional and is used to designate which
custom Page Layouts created by the Statement Designer
will be used when statements are printed for clients that
are assigned this template.

These options apply to all clients who are assigned the specified template. Each client is assigned
two statement templates—one for draft statements and one for final statements. Once a template
has been defined, any changes made to a statement template affect all clients who are assigned that
template. Some firms will have separate statement templates for each timekeeper.
There is no limit to the number of statement templates that can be defined.
Typically, firms will set up a few statement templates to use before they begin to add clients. As
clients are added, they are assigned statement templates on the Statement Options tab of the Client
file. Once statement templates have been set up and fine-tuned, the Statement Templates program is
typically used only when changes or a new template is required.

Figure 16, Statement Format Options

- 10 -

Statement Formatting Guide

Adding a New Statement Template
You can add a new statement template based on default system settings.
▶ To add a statement template
1. From the Statements menu, select Statement Setup icon, and then click Statement
Templates.
2. On the General tab, enter a new Template ID.
3. Enter the Description.
4. Select the desired options on the General, Fee Format, Cost/Payment Format, and Layouts
tabs.
5. Click

to save the new template.

Copying a Statement Template
You can copy an existing Statement Template and then make changes as needed.
▶ To copy a statement template
1. From the Statements menu, select Statement Setup icon, and then click Statement
Templates.
2. On the General tab, select the Template ID you want to use as a basis for the new template.
3. Change the Template ID to the name of the new statement template.
4. In the Description field, enter a description for the new template.
5. Make the desired changes.
6. Click

to save the new template.

Changing the Statement Template Used
When changing the statement template that is used, it can be changed either individually for each
client, for multiple clients at one time, or when running specific statements.

Changing the Statement Template for One Client
You can change the Draft Template and/or Final Template via the Client file on an individual basis.
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▶ To change the statement template used for a single client
1. From the File menu, select Open icon, and then click Client.
2. Select the Client ID for which you want to change templates.
3. From the Statement Options tab, in the Statement Format section, select the desired Draft
Template and/or Final Template.
4. Click

to save the changes to the client.

Changing the Statement Template for Multiple Clients
If you want to change statement templates for multiple clients, you can use the Change Client
Options program.
▶ To change the statement template used for multiple clients
1. From the Maintenance menu, select Client Related icon, and then click Change Client
Options.
2. Select the Client ID range, or click Multiple to select multiple ranges of clients.
3. From the Statements tab, click the Select button.
4. Select Draft Template and/or Final Template and click OK.
5. In the Statement Format section, select the desired Draft Template and/or Final Template.
6. Click OK.

Figure 17, Change Client Options

Changing the Statement Template for One Statement
If you want to change the statement template temporarily, or test how it will look, you can select a
template when generating statements.
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▶ To change the template used at the time statements are generated
1. From the Statements menu, click Generate Statements.
2. Select the Client ID range, or click Multiple to select multiple ranges of clients.
3. From the Options tab, in the Statement Options section, click the Statement Template
button.
4. In the Statement Template Options window, click the Select Template button.
5. In the Template ID field, select the desired Template ID and click OK.
6. Click OK to close the Statement Template Options window.
7. Generate the statement as normal.

Figure 18, Generate Statements Program

After closing the Generate Statements window, the next time you run statements, the template
selected in the Client file will be used unless a template has been defined and saved in a report
definition.
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 19, Customizing Statements Video
Statement Templates Segment

Email Templates
The next level of defining the statement format can be found in the Email Templates window. Email
templates are used by clients who are set up to receive statements via email. Email template options
apply to all clients who are assigned the specified template. Once a template has been defined, any
changes made to the email template affect all clients who are assigned that template. Some firms will
have separate email templates for each timekeeper, category, or billing frequency. If desired, email
templates can also be defined for specific clients.

Setting Up Email Templates
Menu: Statements | Statement Setup | Email Templates
Home: All Actions | Statements | Statement Setup | Email Templates

Each email template must have valid Email Identification information defined in the From Name,
From Address, and Reply To Address fields. When sending via Microsoft Outlook, the Reply To
Address is unavailable and instead is controlled by Outlook. Additional recipients can also be
defined, including entering a firm email address in the Bcc Recipients field to ensure that a copy of
the sent email statement is retained in a single account’s email messages. The Subject and Body of
the email message can be defined using variables from the Available Fields list. Using variables in
place of text allows email statement messages to easily be customized for each individual client or
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matter that is set up to receive statements via email. Additionally, when the cursor is in the Body
field, the Email Template Toolbar is available to format text.
You can include a variable for a ProPay payment link in your email message, which allows clients to
pay their bill online with a credit card, debit card, or eCheck. See Knowledge Base Article R11767,
“Using the Tabs3 Payment Link,” for more information.
There is no limit to the number of email templates that can be defined.

Figure 20, Email Templates

Typically, firms will set up a generic email template before they begin to add clients. As clients who
will receive email statements are added, email templates are assigned in the Bill To Record window,
which is accessed via the Billing Preferences tab of the Client file. Once email templates have been
set up and fine-tuned, the Email Templates program is typically used only when a change or a new
template is required.
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Figure 21, Bill To Record Window

More Info: Additional information on Email Templates can be found in Tabs3 Billing Help and in
Knowledge Base Article R11338, “Emailing Tabs3 Statements.”

Adding a New Email Template
You can create a new email template from scratch.
▶ To add a new email template
1. From the Statements menu, select Statement Setup, and then click Email Templates.
2. Enter a new Template ID.
3. Enter the Description.
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4. Enter the desired information for the email template.
5. Click

to save the new template.

Copying an Email Template
You can copy an existing email template and then make changes as needed.
▶ To copy an email template
1. From the Statements menu, select Statement Setup, and then click Email Templates.
2. Enter the Template ID you want to use as a basis for the new template.
3. Press Esc.
4. Change the Template ID to the name of the new email template.
5. Enter the Description.
6. Make the desired changes.
7. Click

to save the new template.

Changing the Email Template Used
When changing the email template used, it can be changed either individually for each client, for
multiple clients at one time, or for a specific statement run.

Changing the Email Template for One Client
You can change the email template via the Client file on an individual basis.
▶ To change the email template used for a single client
1. From the File menu, select Open, and then click Client.
2. Select the Client ID.
3. From the Billing Preferences tab, in the Statement Delivery Options section, select the Bill
To Name for which you want to change the email template.
4. Click the Edit button.
5. Select the Email Template you want to use.
6. Click OK.
7. Click

to save the changes to the client.
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Changing the Email Template for Multiple Clients
If you want to change email templates for multiple clients, you can use the Change Client Options
program.
▶ To change the email template used for multiple clients
1. From the Maintenance menu, select Client Related, and then click Change Client Options.
2. Select the Client ID range, or click Multiple to select multiple ranges of clients.
3. From the Billing tab, click the Select button.
4. Select Email Template and click OK.
5. In the Statement Delivery Options section, select the desired Email Template.
6. Click OK.
Note: Changing the Email Template using the Change Client Options program will change the
template for all Bill To records associated with the selected client(s).

Changing the Email Template for One Statement
If you want to change the email template temporarily, or test how it will look, you can select a
template when generating statements.
▶ To change the email template used at the time statements are generated
1. From the Statements menu, click Generate Statements.
2. Select the Client ID range, or click Multiple to select multiple ranges of clients.
3. From the Options tab, in the Statement Type section, select Final. Final must be selected
before an email template can be selected.
4. In the Statement Options section, click the Email Template button.
5. In the Select Email Template window, select the desired Template ID and click OK.
6. Generate the statement as normal.
After closing the Generate Statements window, the next time you run statements, the template
selected in the Client file will be used unless a template has been defined and saved in a report
definition.
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 22, Emailing Statements Video

Client Setup
The next level of defining the statement format can be found in the Client file. These options are
specific to the individual client.

Setting up the Client
Menu: File | Open | Client
Home: All Actions | People | Client

The Client tabs we will be looking at include the Setup tab, A/R & Fund Balances tab, Billing
Options tab, Billing Preferences tab, and Statement Options tab.
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Figure 23, Client - Setup tab

Figure 24, Client - A/R & Fund Balances tab

Figure 25, Client - Billing Options tab

Figure 26, Client - Billing Preferences tab
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Figure 27, Client - Statement Options tab

Setup tab

The Setup tab of the Client file includes the billing
frequency for defining client batches and the method to
apply payments.

A/R & Fund Balances tab

The A/R & Fund Balances tab allows you to specify how
client funds are applied, whether there is a minimum
and/or target balance, and how funds are displayed on a
client’s statement.

Billing Options tab

The Billing Options tab allows you to specify billing to
occur when thresholds are met, whether to apply a
courtesy discount, sales tax rates, and finance charge
options.

Billing Preferences tab

The Billing Preferences tab allows you to specify whether
the client will receive statements via mail, email, or both. It
also allows you to specify an additional Bill To contact to
use when a client is to receive a duplicate statement or
when a client’s statement is to be sent to a third party.

- 21 -

Statement Formatting Guide

The Statement Options tab is used to designate the draft
and final statement templates that will be used for this
client and includes an option to combine matters on
statements, cover statement options, and trust integration
information. This tab also contains Beginning and Ending
Statement Notes that allow optional unique statement
notes for the client to print at the beginning and end of
the client’s statement if desired.

Statement Options tab

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 28, Tabs3 Client Overview Video

Statement Notes
There are several different levels of statement notes that can be printed on a statement including
notes individual to the client, notes printed for clients using a specific statement template, and notes
that appear on all clients’ statements. All levels or any combination thereof can be used on a client’s
statement.

Implementing Statement Notes
You can define notes that will be displayed on your clients’ statements via the following areas:
l
l

Client Statement Notes
Statement Notes program
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l
l

Statement Customization program
Miscellaneous Lines

Client Statement Notes
Beginning and Ending Statement Notes of up to 250 characters each can be added for any client.
These notes are unique to the specific client. An example of Client Beginning and Ending Statement
Notes can be seen in Figure 29.
▶ To add Beginning and Ending Statement Notes for a client
1. From the File menu, select Open, and then click Client.
2. Select the Client ID for which you want to add notes.
3. From the Statement Options tab, in the Statement Notes section, enter the Beginning
Statement Notes and/or Ending Statement Notes to be printed on the client’s statement.
4. Optionally Change Notes to blank after statement updated by selecting the Beginning
and/or Ending check box if you want the note to be printed on the next statement only.
5. Click

to save the changes to the client.

Figure 29, Client File
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More Info: Additional information on client options can be found on page 19 of this guide and in
Tabs3 Billing Help.

Statement Notes Program
The Statement Notes program is used to create statement notes of up to 511 characters. Once
created, these notes can be assigned to a Statement Template. Statement Notes will then be used by
all clients who are assigned that statement template. An example of Client Beginning and Ending
Template Notes can be seen in Figure 29.
There is no limit to the number of statement notes that can be defined.
▶ To add a new Statement Note
1. From the Statements menu, select Statement Setup, and then click Statement Notes.
2. Enter a unique Note ID.
3. In the Note Text field, enter the information you want to have included in the note.
4. Click

to save the new note.

Figure 30, Statement Notes

▶ To specify the Statement Notes used on a Statement Template
1. From the Statements menu, select Statement Setup, and then click Statement Templates.
2. On the General tab, select the desired Template ID.
3. In the Statement Notes section, select the desired Beginning Note and/or Ending Note.
4. Click

to save the template.
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Figure 31, Statement Templates

More Info: Additional information on the statement templates can be found on page 8 of this
guide and in Tabs3 Billing Help.

Statement Customization Program
The Statement Customization program provides a way to add nine lines of up to 60 characters each
to be printed as a heading for each billing statement, and a message of up to 250 characters to be
printed at the end of each billing statement. The text entered in Statement Customization is global,
and will print on all billing statements. An example of global heading and ending messages can be
seen in Figure 30.
▶ To add lines of text to a statement using Statement Customization
1. From the Statements menu, select Statement Setup, and then click Statement
Customization.
2. From the Headings tab, enter Lines of text to be printed as a heading on the first page of
each billing statement.
3. Enter Lines of text to be printed as a message at the end of each billing statement.
4. From the Cover Stmt tab, enter text into Line 1 and Line 2 if you want text to be printed at
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the top of cover statements.
5. Click

to save Statement Customization.

Figure 32, Statement Customization

More Info: Additional information on the Statement Customization program can be found on
page 3 of this guide and in Tabs3 Billing Help.
Tip: Statement note text, regardless of where it is defined, can be formatted to include bold, italics,
and underline attributes; can be aligned to the left, right, or center; and can take advantage of
date codes to automatically use the statement date, beginning fee date, or ending fee date.
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Miscellaneous Lines
Miscellaneous Lines 1 through 3 defined on the Custom Fields tab in the Client File are automatically
displayed on statements, as shown in Figure 30, and can be used to add additional information
about the matter. However, if using a Statement Designer Layout, these lines must manually be
added to the Statement Designer Layout.

Figure 33, Miscellaneous Lines

▶ To add Miscellaneous Lines to a Statement Designer Layout
1. From the Statements menu, select Statement Setup, and then click Statement Designer.
2. In the Layout Tree pane, select the desired layout.
3. In the Field Selection pane, expand the Client Fields folder.
4. Click and drag Miscellaneous 1 to the location in the Page Layout pane where you want to
place the line.
5. Repeat step 4 for Miscellaneous Line 2 and 3.
6. Click

to save the layout.

More Info: Additional information on the Statement Designer program can be found on page 29
of this guide and in Tabs3 Billing Help.
Figure 34 is an example of where the various Statement Notes are printed on a statement:
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Figure 34, Statement Notes Locations
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 35, Customizing Statements Video
Statement Customization Segment

Statement Designer
The next level of defining the statement format is the Statement Designer. The Statement Designer
program lets you create customized layouts for your statements that allow you to position images,
text, and data. You can control the placement of various fields from the Client and Bill To files, and
add customized text, images, and other layout elements to the statement. Once a page layout has
been designed, it can be applied to one or more statement templates.

Using Statement Designer
Menu: Statements | Statement Setup | Statement Designer
Home: All Actions | Statements | Statement Setup | Statement Designer

The Statement Designer window includes a Layout Tree pane, a Field Selection pane, and a Page
Layout pane.
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Figure 36, Statement Designer

Layout Tree pane

In the Layout Tree pane, you can manage the layout
groups and page layouts. Each layout group consists of
one or more page layouts. Clicking the plus (+) symbol
next to the name of layout group (e.g., “New Layout
Group”) expands the layout group to display the page
layouts contained therein. Likewise, clicking the minus (-)
symbol next to the name of an expanded layout group will
collapse that layout group, hiding its contents from view.
In the Layout Tree pane of the Statement Designer, you
can add, rename, delete, import and export layout groups,
as well as add, rename, or delete individual page layouts.
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Field Selection pane

The Field Selection pane is used to select and add fields
from the Tabs3 Billing and System Configuration data files
to the current page layout. Clicking the plus (+) symbol
next to a branch in the Field Selection pane (e.g., “Firm
Fields”) expands that branch to show the fields contained
therein. Likewise, clicking the minus (-) symbol next to an
expanded branch collapses that branch, hiding its
contents from view. To insert a field into the current page
layout, double-click the desired field, or right-click it and
select the Insert option.

Page Layout pane

The Page Layout pane is where you control the
appearance of the current page layout. You can add,
remove, or modify various elements such as text boxes,
lines, rectangles, etc., and also control the page layout
properties.

Tabs3 Billing includes a small library of statement layouts with designed letterheads, draft statement
forms, a credit card remittance form, and envelopes that you can modify to use your firm’s
information, thus allowing you to quickly get started with the Statement Designer.
Complete details regarding the Statement Designer can be found in Help.
More Info: Additional information on using Statement Designer can be found in Tabs3 Billing
Help, in Knowledge Base Article R10923, “Frequently Asked Questions About Statement
Designer,“ and in Knowledge Base Article R10901, “Customizing the Sample Page Layouts
Provided with the Tabs3 Billing Statement Designer.“ Additionally, there is an excellent
introductory video that shows the various features available in the Statement Designer. Training
Videos can be accessed at Tabs3.com/videos.

Enabling Statement Designer Page Layouts
Once Statement Designer Layouts have been created or edited as desired, they must be selected in a
client’s Statement Template and enabled in Print Setup in order to be used on a statement.

Statement Templates
The client’s assigned statement template must have the desired Statement Designer Layout selected.
▶ To specify a layout for a Statement Template
1. From the Statements menu, select Statement Setup, and then click Statement Templates.
2. On the General tab, select the Template ID.
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3. On the Layouts tab, in the Page Layouts section, select an existing layout for Page 1.
4. Optionally select an existing layout for Page 2, Envelope, and Cover.
5. Click

to save the template.

Figure 37, Statement Setup - Enable Statement Designer Layouts check box

Note: Changes to a statement template’s settings will apply to every client with the template
selected.
More Info: Additional information on statement templates can be found on page 8 of this guide
and in Tabs3 Billing Help.

Print Setup
Statement Designer page layouts must be enabled for use in the Print Setup.
▶ To enable Statement Designer layouts in Print Setup
1. From the File menu, click Print Setup.
2. Select the Printer to which you print statements.
3. Click the Statement Setup button.
4. Select the Enable Statement Designer Layouts check box.
5. Click OK on the Statement Setup window.
6. Click OK on the Print Setup window.
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Figure 38, Statement Setup - Enable Statement Designer Layouts check box

More Info: Additional information on enabling Statement Designer Page Layouts can be found in
Tabs3 Billing Help and in Knowledge Base Article R10944, “Printing Statements with Statement
Designer Page Layouts.”

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 39, Customizing Statements Video
Statement Designer Segment

Bitmaps and Image Files
Certain image files can be included on your billing statements for a letterhead, or to enhance the
heading. Bitmap files (*.bmp) can be added via Print Setup if you do not want to set up a Statement
Designer Layout, or you can include *.bmp, *.jpg, and *.png files in your Statement Designer Layout.

Enabling Bitmaps or Image Files
Use one of the following methods to add bitmaps or other images on your statement.
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▶ To add a bitmap via Print Setup
1. From the File menu, click Print Setup.
2. Select the printer to which you will be printing statements.
3. Click the Statement Setup button.
4. In the Page One section, select the Bitmap check box.
5. Optionally enter a Bitmap Vertical Placement.
6. Select a Bitmap Alignment.
7. Click OK on the Statement Setup window.
8. Click OK on the Printer Setup window.

Figure 40, Printer Setup

▶ To add a bitmap or other image file via Statement Designer
1. From the Statements menu, select Statement Setup, and then click Statement Designer.
2. Select the Layout to which you want to add an image.
3. Click the

toolbar button.

4. Select the image file you want to have printed on statements.
5. Click the Open button.
6. Move the image to the desired placement.
7. Click

to save the Statement Designer layout.

Tip: Software Technology offers a letterhead scanning service for a nominal fee. You can send us
the letterhead you want scanned, and we will produce a bitmap file that can be used to print your
firm’s letterhead on Tabs3 Billing statements. For more information on our scanning service, visit
Knowledge Base article R10168, “Bitmap Scanning Service.”
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Trust Accounts
When a Tabs3 Billing client is set up for Trust Integration, customized terminology can be used for
trust account balances and activity on the billing statement.

Trust Account Integration and Terminology
Use the following to customize how trust accounts are shown on statements.
▶ To display trust information on statements
1. From the File menu, select Open, and then click Client.
2. Select the client for which you want trust information displayed on statements.
3. Click the Statement Options tab.
4. In the Statement Format section, in the Trust Integration field, select Detail or Summary.
5. Click

to save the changes to the client.

Figure 41 is an example of how trust activity appears on the statement when the Detail option is
selected:

Trust Account Activity
Opening Balance
10/04/18 Expense money for Dawson
PAYEE: Charles L. Dawson
10/10/18 Sale of Stock
10/11/18 Attorney fees
PAYEE: Jensen & Burns, P.C.
10/17/18 Real Estate taxes
PAYEE: Lancaster Country Treasurer
Closing Balance

$52,000.00
-1,200.00
4,255.75
-443.75
-1,450.00
---------$53,162.00

Figure 41, Example of Detail trust activity on a statement

Figure 42 is an example of how trust activity appears on the statement when the Summary option is
selected:
Your retainer balance is $53,162.00
Figure 42, Example of Summary trust activity on a statement
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▶ To customize terminology for trust accounts
1. From the Trust Accounting Software File menu, select Open, and then click Miscellaneous.
2. Click the Bank Account tab.
3. Select a Bank Account.
4. Click the Integration Settings button.
5. In the Tabs3 Statement/WIP Terminology section, enter the desired balance and remittance
text.
6. Click

to save the changes to the bank account.

Figure 43, TAS - Tabs3 Statement/WIP Terminology

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.

Figure 44, Tabs3 Trust Accounting Integration Video
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Conclusion
Resources
Tabs3 Billing statement customization features provide the tools to give your statements the look
you want. Additional information on the features discussed in this guide can be found in the Tabs3
Billing Help. Simply press F1 from anywhere within the software to load the Help information for that
particular topic.

Guides and Sample Statements
Additional guides and resources for other software features are also available, including the
following:
l

l

Statements Guide - This guide provides an overview of the process of generating monthly
billing statements.
Tabs3 Billing Sample Reports - Over 20 pages of sample statements, and the formatting
options that were used to create the statements, can be found in the Tabs3 Billing Sample
Reports.

All guides and sample report packs are available on our Web site at:

Tabs3.com/support/docs.html

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.
l

R11582 - “Statements Information Resources,“ is a comprehensive list of Knowledge
Base Articles containing more information about Tabs3 Billing statements.

All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com

Training Videos
You can view the following training videos for more information. Clicking an image will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/t3video.
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Figure 45, Customizing Statements Video

Figure 46, Emailing Statements Video

Figure 47, Client Overview Video

Figure 48, Trust Accounting Integration Video
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